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INTRODUCTION 

What Is ERMA?  
The Environmental Response Management Application (ERMA®) is a web-based geographic 
information system (GIS) tool that helps emergency responders and environmental resource managers 
deal with incidents that may adversely impact the environment. ERMA combines real-time and static 
data to display a single interactive map that makes it easy for users to visualize an active environmental 
situation or long-term case assessment. 

Because ERMA is web-based, users do not have to download any proprietary software onto their 
computers. It also offers the following advantages: 

• It facilitates the integration and synthesis of various types of information. 
• It provides a common operational picture to all individuals involved in a response. 
• It improves communication and coordination among responders and stakeholders.  

ERMA gives resource managers the information they need to make informed decisions when dealing 
with an incident. The maps it generates are worth the proverbial “thousand words” when 
communicating the status of response activities. 

What You'll Find in This User Guide 
This guide gives an overview of how ERMA works, and then describes what a new user needs to know 
about ERMA’s interface and basic tools. Some of the functions described are available only to ERMA 
users with accounts or are restricted to users who have certain privilege levels.  

The guide contains these sections: 
• ERMA Basics gives an overview of ERMA, including a brief history of the system’s origins and a 

discussion of ERMA’s software architecture.  
• Getting Started tells how to get an ERMA account, how to log in to ERMA, and describes how 

to use the different parts of the ERMA window. 
• Using the ERMA Window will familiarize you with the different areas of the window and where 

to find the different tools and data layers. 
• Layers Tab where you will find all the layers, or datasets, available in ERMA. Depending on the 

region, its activity level, and your account access there can be hundreds or even a few thousand 
layers in one site. Because of the volume of information, the layers are organized into categorical 
folders and sub-folders that are consistent throughout all the regional ERMA sites. Some of the 
layers are found in all the ERMA sites, and some of the layers are specific to one region 

• Query Tools Tab describes how to create and edit polygons that you can use to analyze the 
data available for an area. It also explains how to access data in the NOAA Environmental 
Sensitivity Index (ESI) maps and in the U.S. Fish and Wildlife Service Information, Planning, and 
Conservation Tool (IPaC). 

• Zoom Tab describes the tools you can use to zoom to specific map locations using latitude and 
longitude coordinates, vessels, or place names. 
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• Download Tab explains how to save ERMA data to your computer. 
• Print Tab describes how to print the maps and data displayed in ERMA. 
• Draw Tab explains how to draw points, lines, and polygons on the map to create drawings that 

you can share with other ERMA users. 
• Appendix provides more information on ERMA such as websites and citations
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ERMA BASICS 
ERMA is an online mapping tool offering comprehensive access to localized environmental response 
information. ERMA integrates both static and real-time data, such as Environmental Sensitivity Index 
(ESI) maps, ship locations, weather, and ocean currents, in a centralized format. It provides 
environmental responders and decision-makers with access to data for environmental planning, 
response, assessment, restoration, and incident drills, as well as for other incidents and natural 
disasters. The system incorporates data into a fast, user-friendly GIS that can be accessed by command 
post staff, by active field and remote support teams, and by decision makers and other incident and 
restoration staff at a variety of locations.  

ERMA was developed in 2007 by the National Oceanic and Atmospheric Administration (NOAA) and 
the University of New Hampshire with the Environmental Protection Agency, U.S. Coast Guard, and the 
Department of the Interior in a cross-agency effort. It is currently organized into eight regional sites: 
Atlantic, Caribbean, Gulf of Mexico, Southwest, Pacific Islands, Pacific Northwest, Arctic, and the Great 
Lakes.  

Making ERMA Go: The Technology that Powers ERMA 
ERMA is an integrated data management system that incorporates static base layers along with real-
time streams of data (such as weather, tides, and ship tracking) into a fast, user-friendly GIS that is 
accessible to anyone with access to the Internet, whether in the field or at an agency headquarters. 
ERMA enables a user to quickly and securely access GIS data, photos, and imagery that can be used to 
solve complex environmental response and resource issues.  

The application is based on open source software (PostgreSQL/PostGIS, MapServer, and OpenLayers), 
that meet Open Geospatial Consortium (OGC) specifications and standards used across federal and 
international geospatial standards communities. This ensures ERMA is compatible with other 
commercial and open-source GIS applications that can readily incorporate data from online data 
projects and avoids licensing costs. Open-source compatibility supports data sharing, leverages 
existing data projects, reduces ERMA’s maintenance costs, and ensures system flexibility as the 
technology advances. Because ERMA is open source, it can easily be customized to meet specific user 
requirements. 

ERMA operates in the Federal Information Security Management Act (FISMA) Amazon Cloud, which 
allows the application to scale as needed for big and small events. The illustration below shows ERMA’s 
basic software architecture and data flows. 
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ERMA Security 
ERMA enacts a number of security measures to ensure that the datasets used in ERMA are accessible 
only to those who should have access. Both the data layers and the users are given security levels to 
determine who sees what in ERMA. 

Layer Security 

Each layer that is brought into ERMA, either as a static shapefile, or as a data feed from an external 
partner, is given a security sensitivity level. For example, Public, NRDA, or Responder. There are several 
other categories that rank in order of highest to lowest sensitivity level. The ERMA Regional Leads work 
with the data originator to determine what level their data should have. 

User Accounts & Security 
In conjunction with the layer security levels, each user is given their own account privilege that 
determines what layer sensitivity levels they will see. These privileges are determined by their agency 
and staff role, and NOAA Sponsor recommendation.  Each user account is vetted by an ERMA Account 
Manager who looks at the user’s request and customizes their account based on the existing NOAA 
security requirements. 
 
Together, the ERMA layer and user account security measures ensure that data are available only to 
the appropriate users for their appropriate use.
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GETTING STARTED 

Getting an ERMA Account 
ERMA can be accessed by anyone to view publicly-accessible data. To access restricted, non-public 
data, ERMA users who are active in the environmental response, planning, restoration, and assessment 
community can apply for an ERMA account. Each account request requires a NOAA Sponsor and is 
reviewed by an ERMA Account Admin before being approved. 

To get a new ERMA account: 

 On the ERMA home page, click the Login command in the upper-right corner of the screen. 

 

 When the Login window appears, click Request Account. A new browser window opens. 

 

 

 Enter the requested information. While the information you need to provide for many of the 
fields are self-explanatory, you'll find more details about some of fields below the illustration.  

IMPORTANT: You must provide information for all fields that are marked ‘Required.’  
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• Email Address: Enter a full work email address. Personal email accounts such as a Google Mail 

or Hotmail do not meet our security protocols. 
• Affiliation: Open the drop-down list and select the type of organization that you are affiliated 

with. If none of the listed categories fit your organization, select Other. 
• Agency Represented: Enter the name of your agency or organization. 
• Contractor: If you work for your organization on a contract basis, select Yes. Otherwise, select 

No. 
• Company: If you are a contractor, enter the name of the contracting company that you work 

for.  
• NOAA OR&R Sponsor: Enter the name of the NOAA Office of Response & Restoration 

representative who suggested that you use ERMA and who can verify you for an account. 
• Incident Command Post: If you are part of an active response, enter the name of your 

incident command post. 
• Office Location: Enter the location of your incident command post or, if you are not part of 

an active response, the home city of your organization. 
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• Notes: Enter any additional information that would be pertinent to the creation of your NOAA 
account. 

4. Click Submit.  
Requests for ERMA accounts are processed by the account management team during regular business 
hours (Monday through Friday from 8 A.M. to 5 P.M.). Processing will be more frequent during a drill or 
incident. Once your account has been processed you will receive an email from the account 
management team about accessing ERMA, how to find basic information, names of the ERMA regional 
leads, and basic documentation. 

 

Setting Up Passwords and Account Maintenance 

Your password and user account are an important part of keeping ERMA secure. There are NOAA 
security guidelines to follow for password creation and user account management, including the 
following password requirements: 

 

 
 
• Every 90 days, your password will expire. When you login, you will be prompted with a message 

notifying you to reset your password.  You may change or reset your password before then by 
clicking the “Change Password” function at the top right of the page. 

• If you have not logged into ERMA for 6 months, your account will expire. Before this happens, 
you will receive an automated email 2 weeks in advance notifying you of this occurrence and to 
log in again. You will also be required to create a new password.    

• If you have not logged into ERMA longer than 6 months and your account is expired, when you 
try to log in a notice will appear to contact the orr.ermaaccounts@noaa.gov email. Your account 
will be reviewed and reactivated based on information provided. 

 

mailto:orr.ermaaccounts@noaa.gov
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Recovering Your Password 

To recover your password if you forget or lose it: 

 On the ERMA home page, click the Login command (located in the upper-right corner of the 
screen). 

 When the Login window appears, click Recover Username/Password. 

 

 When the Password Recovery window appears, type your email address (the same address you 
used when you initially requested your account) in the field provided. 

 

 Click Submit. An automated email will be sent instructing you to create a new password. 

Recovering Your Username 

To recover your username if you forget or lose it: 

 On the ERMA home page, click the Login command (located in the upper-right corner of the 
screen). 

 When the Login window appears, click Recover Username/Password. 
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 When the Username/Password Recovery window appears, type your email address (the same 
address you used when you initially requested your account) in the field provided. 

 

 Click Submit. An automated email will be sent containing your username information. 

Logging In and Out 

To log in to ERMA: 

 On the ERMA home page, click Login in the upper-right corner of the screen. 

 

 When the Login window appears, enter your username and password.  

 Read the terms of use detailed in the scrolling box, and once you have checked the box “I Agree”, 
Click OK. A message will tell you that your login was successful.  

 Once you are in ERMA you will see a Table of Contents to your right containing data layers and 
additional tools and tabs made available to those who hold ERMA accounts. Users who have access 
to multiple Regional ERMA sites can go to them without logging in again.  

To log out of ERMA: 

Click Logout in the upper-right corner of the ERMA window. All restricted folders and layers disappear, 
and a message tells you that the logout was successful. 

NOTE: If your ERMA window has been inactive for 2 hours, you will be automatically logged out. 
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USING THE ERMA WINDOW 
ERMA data is accessed and displayed using the ERMA window. The elements of this window are shown in the illustration below.  
 Login/Logout 
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The rest of this section describes these elements, starting with the Map Controls and working around 
the window clockwise. 

The upper-left corner of the ERMA window contains several tabs including the Information tab, Help 
tab, and Recent Data tab. 

 

• The Information tab opens a window containing general and design information about ERMA. 
• The Help tab opens a window containing basic information about using ERMA, including the 

use of the Map Toolbar and Navigation tabs. 
• The Recent Data tab opens a window containing links to data that’s been uploaded recently. 

Only the layers that you have the privileges to view will be visible. By default, you will be shown 
layers added to your ERMA region the past 90 days, but you can enter a new number to increase 
or reduce the number of days. 

 

 

Map Controls 
The Map Controls are located in the upper-left corner of the map. It contains the following controls. 

 

Zoom Level Control 
Allows you to zoom in and out of the map to increase or decrease the zoom level, showing 
more or less detail.  
To zoom, click the plus or minus sign on the Zoom Level Control until you’ve reached the 
desired zoom level. You can see the new zoom level and map scale in the Map Key at the 
bottom of the ERMA window. 
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Map Toolbar 
The Map Toolbar is located just to the right of the Map Controls. It contains the following controls and 
tools. 

 

 

 

Pan Tool 
Allows you to reposition the map by clicking on a spot and dragging the 
map.  
To reposition, select the Pan Tool icon and then click a spot on the map. 
Hold down your mouse button and drag the map until you have the view 
that you want. (This tool is selected by default.) 

 

Magnifier Tool 
Allows you to re-center the map on any desired point and then zoom in 
on that spot.  
• To re-center, click the Magnifier Tool icon and then click anywhere 

on the map. Each successive click zooms in on the map’s new center.  
• To zoom in on a specific area, click the Magnifier Tool icon and then 

use your mouse pointer to draw a box around the area of interest. 
When you release the mouse button, ERMA zooms the map in on the 
area you selected.  

You can see the zoom level, map scale, and the latitude and longitude of 
the map’s new center in the Map Key at the bottom of the ERMA window.  

 

Previous Extent 

Allows you to zoom the map to the previous geographic extent. It 
does not revert to previous data layers. 
Click the icon to switch to the previous map extent without changing any 
of the currently selected layers. If the icon is white, there is no map extent 
saved. 

 

Next Extent 
Allows you to zoom the map to the next geographic extent. 

Click the icon to restore the next map extent without changing any of 
the currently selected layers. If the icon is white, there is no map extent 
saved. 
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Measurement Tool 
Allows you to draw a line or polygon on the map to measure distances. 
To draw a line or polygon, click the Measurement Tool icon and then 
select which type of feature and measurement value to use. Begin by 
clicking a point on the map where you want the feature to start. If you 
single-click at another point, you can continue the feature in another 
direction. Double-click when you want to end the feature. You can see a 
running total of the feature’s value on the map. Create multiple features 
at the same time. To make them disappear click on another Map Tool 
button. These features are temporary and not saved to the map. 

 

Identify Tool 
Allows you to select a point on the map and see attribute information for 
the layers that are turned on at that particular location.  
To see the attribute information, turn on one or more layers. Click the 
Identify Tool icon and then click the desired point on the map. Attribute 
information will appear in a pop-up window. 
Clicking anywhere on the map will also open a pop-up window returning 
the lat/long of the location.  

Search Box 
The Search Box is located at the top-center of the ERMA window. 

 

This tool is useful when you want to search for layers, folders, bookmarks, or geographic locations of 
interest without having to look through multiple folders. Instead, you can enter a word or phrase (which 
must contain at least three characters) into the Search Box and generate a list of results consisting all 
of the layers, folders, or bookmarks that have your search term in their names.  If you would like to 
search by geographic name or latitude/longitude, check the “Geographic Search” box and type in the 
location in the search box. A drop-down list of locations will be displayed. 
  



 

ERMA Basic User Guide: Using the ERMA Window 

16 

To use the Search Box to find information in ERMA: 

 Type the word or phrase that you are interested in. A list of relevant folders, layers, metadata, 
and bookmarks appears in a drop-down list. 

 

 You can now select items starting with any of the following:  

 

• Activate layer: When selected, the layer is activated, and the data it contains is available for 
analysis on the map. 

• Activate layer [metadata]: When selected, the layer with the search term in its metadata is 
activated. Right-click on the layer name then View Metadata to read the information. 

• Show Bookmark: When selected, a pre-selected group of layers (called a Bookmark View) is 
displayed on the map. 

• Expand folder: When selected, the folder is expanded on the Table of Contents, which allows 
you to look through the folder for other layers that may be helpful. 
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Tool Tabs and Table of Contents  
The Tool Tabs and the data layers’ Table of Contents (TOC) sit on the right side of the ERMA window. 
The TOC is accessible via the “Layers” Tab. The rest of the tabs in this part of the ERMA window display 
panels for tools that let you analyze and download ERMA data.  

 
 

These tools are available on the Table of Contents:  
• Layers 

Allows you to view the layers of information that can be displayed on the map. This tab also 
allows you to access the Bookmark Views.  

• Legend 
Helps you interpret the symbology used in the layers displayed on the map. Legend 
information is automatically generated or updated each time new or different layers are 
selected for display. 

• Query Tools 
Allows you to create and edit polygons on the map and then analyze the data available for 
that area. It also allows you to access data in the NOAA Environmental Sensitivity Index (ESI) 
maps and in the U.S. Fish and Wildlife Service Information Planning and Conservation Tool 
(IPAC).  

• Zoom 
Allows you to zoom in on a particular location by latitude and longitude; by the place name; 
by ship identification number or ship name. 

• Download 
Allows you to download certain types of ERMA shapefile information to your computer.  

• Print 
Allows you to generate a PDF of the map displayed in the ERMA window to print or save. 

• Draw (Available only to users with the required privileges.)  
Allows you to draw points, lines, and polygons on the map to create a drawing that you can 
share with other ERMA users.  
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Bookmark Views Control 
The Bookmark Views control is at the bottom of the Layers tab on the Table of Contents. Use this 
control to open the Bookmark Views panel and create a new Bookmark View. More information on 
using Bookmarks is in the Layers Tab section. 

  

 

 

Expand/Hide 
Opens and closes the Bookmark Views panel. 

Display Controls 
The Display Controls are two buttons located in lower-right corner of the ERMA window.  

 

 

Clean 
Allows you to make most of the controls, tabs, and buttons on the ERMA map invisible. (Only 
the Map Key and the tab you are currently using stay visible.) This is especially useful when 
taking screen shots or preparing a map for a presentation. 
To restore the hidden elements, click anywhere on the ERMA window. 

 

 

Hide/Display TOC 
Toggles the display of the Navigation tabs and Table of Contents (TOC) and expands the map 
to fill the full ERMA window. 
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Map Key 
The Map Key is located in the lower-left portion of the map in the ERMA window. 

 

The Map Key has the following elements: 
• Scale bar: A graphic showing how many feet/miles or meters/kilometers are represented by a 

set length on the map.  
• North arrow: An arrow with a letter N pointing to the map’s northerly direction. 
• Scale: A fractional scale showing the ratio between a set length on the map and the real-world 

distance that this length represents. In the illustration above, one unit on the map represents 3 
million units in the real world.  

• Zoom Level: The zoom level for the current map display, as set on the Zoom Level control. 
Levels range from 0 (zoomed out to show the full map) to 19 (zoomed in as far as possible). 

• Location: The lat/long location indicated by the mouse pointer, to an accuracy of 1/100000 of 
a degree. 

Except for the north arrow, all of these elements update automatically to reflect changes in the zoom 
level or movement of the mouse pointer.  

 



 

 

 

LAYERS TAB  
The Layers tab is where you will find all the layers, or datasets, available in ERMA. Depending on the 
region, its activity level, and your account access there can be hundreds or even a few thousand layers 
in one site. Because of the volume of information, the layers are organized into categorical folders and 
sub-folders that are consistent throughout all the regional ERMA sites. Some of the layers are found 
in all the ERMA sites, and some of the layers are specific to one region. 

The following sections provide more information on using the layers in ERMA. 

Base layers in all regions 
All of the ERMA regions have a large set of core base layers in common that are mostly publicly 
accessible without an account. These include national-level datasets such as Weather, Oceanographic 
Conditions, Nautical Charts, Administrative Boundaries, and Infrastructure. These base layers are to 
provide consistency and cohesiveness between the regions, so that if you are familiar with one ERMA 
region it should be seamless to transition to working on another region. 
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Legend & Symbology 
The Legend tab explains the symbols used on the map to represent information. These colors and 
shapes help users to understand what they are seeing on the map. Legend information is automatically 
generated or updated each time a layer is created or edited. Legend styles are populated from the 
styles that are set for a particular layer. 

 

Background layers 
Each ERMA region has the same Background Layers available. These provide a variety of options for 
overlaying data or for seeing additional background features on your map, such as satellite imagery 
or oceanographic feature names. We do not provide GoogleMap background layers due licensing 
agreements. However, we find that the background layers in ERMA, such as Open Street Maps and 
ESRI, provide excellent and occasionally better options. 
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Region specific layers 
Each ERMA Regional Liaison works with state, federal, and local agencies to curate the most relevant 
and current datasets for their area. This allows ERMA to act like a portal for displaying a broad set of 
information important to environmental response and planning for that area. These regional layers 
include information such as natural resources, endangered species, response planning, environmental 
quality sampling, and imagery. 

The regional layers will include information on the source of the data, when it was published, and the 
agency’s website. We encourage our users to always seek out the data from the original source for the 
most up-to-date information. 
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Incidents & Drills 
The Table of Contents includes a folder called Incidents & Drills that contains subfolders for any drill 
exercises or incidents that have used ERMA for data display. There is also a folder for NOAA OR&R 
ResponseLink Hotline records that are being investigated. The drill folders and data are archived after 
six months, and the incident folders and data are archived after one year. 

 
When an incident is actively being responded to and using ERMA for its Common Operational 
Platform, its folder is moved to the top of the Table of Contents for easier access. Once the incident 
response has ended and its Natural Resource Damage Assessment has found resolution the folder is 
moved into an archive section in the Table of Contents. Many of the layers that were used during the 
incident are now used as base data in the Table of Contents going forward. 
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External Server Feeds vs Static Data Layers 
ERMA’s Table of Contents is made of many different layer types, which can generally be classified as 
either static or external server feeds. Static layers are loaded into ERMA once and do not change unless 
they layer is manually replaced in the ERMA database by a new one. These include data types like 
shapefiles or photos.  

External server feed data layers are brought into ERMA through an external agency’s web server or 
data system, and the data are continually or intermittently updated on their server. For example, the 
weather data that ERMA displays from the National Weather Service is hosted on the NWS server and 
continuously updated with their data in near real-time, which ERMA displays. Another example is field 
data collected by the EPA, which is managed by their data managers and hosted on their server, but 
might be updated once a day or once a week. This allows ERMA to display their data, but to keep the 
ownership in the hands of our partners.  

While the user can’t automatically differentiate whether the data they are using are static or from an 
external server, a review of the metadata should provide enough information on the source of the 
data. 

Imagery 
Historic and recent imagery can provide valuable information on the changes and impacts to a coastal 
environment. This can include imagery that shows flooding and debris from hurricanes, the footprint 
of oil on the ocean surface far offshore, and the success of restoration projects in local communities. 
We work with several agency partners to collect this historic imagery in vulnerable locations like the 
Arctic and Gulf of Mexico. After an oil spill or hurricane, we obtain imagery from overflights and 
satellites immediately after it is processed so that it can be displayed in ERMA and aid in decision 
making. 

Photos 
The photos taken by field staff are often the best way to visually communicate the state of how the 
coastal environment has been impacted. They provide immediate context of the situation, but in the 
long term, they also provide evidence used in the Natural Resource Damage Assessment case to show 
how, where, and when resources have been compromised. Our field staff and data managers follow 
strict photo protocols so that all the forensic data is intact. The photos are geographically referenced 
and displayed in ERMA, which allows to user to see exactly what the field person saw at that time, and 
to also to overlay the photo with other spatial information to add to the story. 

Attribute Table URL Links 
Many layers in ERMA have additional information linked through their attribute table, such as links to 
external websites or PDF documents. You will know there is additional information available when a 
small lightning bolt icon appears next to the layer name. 
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Clear All, Collapse All 
Two handy tools to use when working with layers and Bookmarks in ERMA are the Clear All and 
Collapse All links at the top of the TOC in the Layers tab. They appear in small gray font, but are 
something you should learn to use often. The Clear All link will turn off all layers on the map, and the 
Collapse All link will collapse any folders and subfolders that have been expanded.  

 

Layer Attachments (Documents, JPGs, URLs) 
In addition to displaying data on the map, ERMA can also provide links to more information about the 
data. Small icons next to the layer name will link to other information such as a webpage, a PDF 
document, a spreadsheet, or a photo. To access the external website or document just click on the 
icon. 

Icons with links to a webpage or PDF document 

 
 

Icons with links to a spreadsheet document 

 
 

Icon with a link to a photo 
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Layer Shortcut Menu 
This shortcut menu appears when you right-click on the name of a selected layer. It allows you to 
perform specific operations on that layer, such as zooming to the layer’s extent, viewing the attribute 
table data, or displaying metadata. The active commands on this menu vary from layer to layer.  

 

 

View Metadata 
It is important to have metadata to answer the Who, What, Why, Where, When of each layer. ERMA 
provides “metadata lite” via the View Metadata shortcut to give the user a quick overview of the 
information. When available there is also a link to the full FGDC metadata as provided by the originator 
of the dataset. 

 

Zoom to Extent 

This shortcut option will zoom to the full extent of the layer, which is useful to see its full geographic 
scope on the ERMA map. 



 

ERMA Basic User Guide: Layers Tab 

27 

Bring to Front & Send to Back 
When multiple layers are turned on, this is useful to move layers in front of or in back of each other so 
they can be seen more easily. 

View Attribute Table Data 
Right click on a layer to open the shortcut menu, then click on View Data to open its attribute table. 

 
 

With the attribute table open you can: 

• Sort the columns alphabetically or numerically 
• Search for words in the columns to filter the data 
• Select records with by clicking the row with your mouse to highlight them on the map.  

 
As explained in the Adding Attributes Records to the Query by Polygon Tool section, if these 
features are polygons you can also add them to the Query Tool to analyze with other datasets. 
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Time Slider 
Some layers in ERMA have time-associated data that allows us to display the data as animation over a 
period of time, for example weather observations, oceanographic currents, and imagery. These types 
of layers have the Time Slider “clock” icon next to the layer name.  

 
  

To use the Time Slider in ERMA: 

 In your layer TOC, you should see a clock icon ( ) next to certain layer(s). 

 To activate the Time Slider player, turn on the layer, and then click on the clock icon.  

 The Time Slider tool will appear at the bottom of the ERMA map. 
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The following explains how to use the Time Slider for your layer: 

 
In this example, the layer has data available from 12/20/2017 at 8 a.m. to 12/20/17 at 11 a.m. Its time 
zone is set to New York, Eastern Time, which is read from your computer’s settings. 

 

 
Previous Time Step 
Allows you to go through the previous time steps  

 
Or 

 

Play or Pause 
Allows you to play the time slider or pause at a desired time.  
 

 
Next Time Step 

Allows you to go through the next time steps 

 
Or  

 

Stop or Loop 
Allows you to stop the time slider at the end or you can continue to the play the time slider 
from the beginning to the end. 
 

 
Time Slider Settings 
Allows you to select setting options for the Time Slider 

 
Time Slider Help 
Help text that further explains the time slider settings options  

 

When the Time Slider settings are opened you have the following options: 
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1. To increase or decrease the speed of the animation, slide the bar between Slow (0) and Fast 
(100). 

2. Change the Time Zone, default is your computer’s settings. 
3. Change the Time Extent to the length of all time-enabled layers displayed, or restrict to the 

time extent of only one layer. By default, the time slider will be the cumulative time period of 
all layers added to the time slider. 

Bookmark Views 
ERMA's Bookmark View function allows you to access preset groups of data of particular interest. 
Rather than recreating sets of data at the same geographic extent every time you use ERMA, the 
Bookmark will take you to that set of data and extent each time. The ERMA data managers will also 
edit the Bookmarks to make sure they contain the most relevant data possible.  

Examples of useful Bookmarks include base data and field sampling for a sensitive area. The Bookmark 
can be routinely updated with new, separate layers to make a more comprehensive story for that area. 
Another example is a hurricane response, where several times a day the responders will want to see 
several layers that are constantly being updated. Rather than try to remember where all these layers 
are in the TOC, it is far simpler to click on the Bookmark to access them immediately. 

 

To use the Bookmark Views 

1. Click the Expand button on the Bookmark Views control at the bottom of the Layers tab to 
open the Bookmark Views panel. 

 

2. Once the panel has expanded you will see Bookmarks (in blue text) and also folders nested 
with more Bookmarks of a common topic.  
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3. Click on one of the Bookmark names. The layers will appear on the map and it will zoom to the 
preset zoom level. The TOC will update to show only those layers included in the Bookmark.  

 

4. At the top of the TOC is the Bookmark’s name and an Info button. Clicking this button will pop 
open a new small window giving you information on when the Bookmark was last modified 
and a link that you can share with others.   

 

NOTE: The number at the end of this Bookmark link (ex. View=1738) will not change over time, 
even when new layers are added or edited to the Bookmark. This is a convenient way to share 
the link in a document or with others without worrying about changes to the link. If the Bookmark 
is deleted, however, it will not be accessible any longer. 
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5. To exit the Bookmark back to the full TOC, click the Show All Layers link at the top of the TOC. 
You may also want to click on the Clear All and Collapse All links. 

 
To close the Bookmark Views panel, click the Hide button on the Bookmark Views control.



 

 

QUERY TOOLS TAB 
One of the powers of GIS data is the ability to spatially query layers on a map and extract the data 
from within an area of interest. ERMA has a query tool that allows you to create one or more polygons 
on the map then analyze ERMA layers using the query tools described in this section.  

Using Polygons to View and Analyze Data 
ERMA provides three tools for viewing and analyzing data using the polygon(s) that you have created. 

• ERMA Layer Query by Polygon Tool – Queries ERMA layers being viewed on the map. 
• NOAA ESI Query Tool - Queries the regional Environmental Sensitivity Index (ESI) database 

within the map view. 
• U.S. Fish and Wildlife Service IPaC Tool – Queries the external Information for Planning and 

Consultation (IPaC) database.  

Creating Polygons for Analysis 

Creating a Polygon 

To create a shape on the map: 

 On the ERMA window, click the Query Tools tab. 
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 Click Create Polygon. A message tells you that the Polygon Tool is active. 

  

 To make a polygon, click on a spot on the map and then move the mouse pointer to draw the 
polygon’s first side. For each additional side, click again and draw the new side. To make a 
smoother polygon or circle, hold down the Shift key while drawing with your mouse. Double-click 
to end the drawing. 

 

 To edit the polygon, click on the edge and move the line to its new location. 

 When the map displays the shape that you want, double-click to end the drawing. 
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 You can create as many polygons as you like for querying. Repeat steps 2 through 4 for each 
additional polygon.  

Deleting Polygons 
ERMA allows you to delete single polygons or all of the polygons on the map at once.  

To delete a single polygon: 

 Click on the polygon that you want to delete and it will be highlighted in dark blue. 

 

 Click Delete Selected. The selected polygon disappears from the map. 

 To delete all of the polygons on the map click Delete All. 
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ERMA Layer Query by Polygon Tool 
The ERMA Layer Query by Polygon Tool allows you to create a subset of all active layers that are 
contained completely within the polygon(s) that drawn on the map, or which intersect the drawn 
polygons. All data for active layers is returned in a new browser window, and it can then be exported 
as: 

• An Excel spreadsheet 
• A KML (Google Earth) file 
• A shapefile  
• A SpatiaLite (SQLite) database 

Metadata is available for each layer and is included in the export.  

IMPORTANT: The ERMA Layer Query by Polygon tool returns data for ERMA-hosted layers only (i.e. 
Internal services such as shapefiles). It does not return data for layers that are hosted externally (i.e. 
External WMS feeds such as NOAA Nautical Charts or AIS vessels). If your selected layer is not able to be 
queried, a Comment in the results table will say “This layer is external to ERMA…” 

 

To query ERMA layers: 

 On the Layers tab, turn on all of the layers that you want to query so they appear on the map. 

 On the Query Tools tab, create one or more polygons using the procedure in Creating a Polygon. 

 Click on the polygon(s) that you want to use in your query. To select multiple polygons, press the 
SHIFT key and click on each polygon you want to include. 

 Select one of these query types: 
• Select all features that touch these polygons (intersect) returns data for any feature in an 

active ERMA-hosted layer that is wholly or partially contained in the selected polygon(s).  
• Select only features COMPLETELY inside these polygons (contains) returns data for any 

feature in an active ERMA-hosted layer that is wholly contained in the selected polygon(s). 
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 Click the Run ERMA Query By Shape button. ERMA will generate a subset of records based on 
your selections, and then display a new window tab similar to the one below. 

 

 

The Results Summary tab lists each layer for which data exists and tells you whether there is data 
that could not be included because it is hosted externally. Separate tabs for each layer, denoted 
by the Layer ID Number, let you examine the layer’s attribute data results in more detail. 
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 On the Layer ID tab, you can reorder a column’s records using the Sort arrows next to the field 
name. Click the arrows once to sort alphabetically or numerically. Click them again to reverse the 
order. 

 
 You can reorder the columns and field names left to right by grabbing the field name with your 

mouse and dragging it to a new location. 

 You can customize the field names that you see by clicking the Columns Shown button. A list of 
the field names will appear. Check or uncheck the names you’d like to see or dismiss. 

 
 

 You can perform simple filters to search for words or numbers under each field name. 

• Choose a field in which you would like to search and make a subquery. In the Search box 
under the field name, type the word or numbers and the records will automatically filter. 
Quotes are not needed. 
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Example: Typing the phrase “LCP Chemical” in the “StudyName” field brings up all records with 
the phrase “LCP Chemical”. 

 
10. To show the results of your Query by Polygon or your subquery on the ERMA map, click the Add 

to Map button. A dialog will open for you to name your new layer. 

NOTE: You must be logged into ERMA for the Add to Map button to appear. This Query by Polygon layer 
is temporary and not a permanent layer in ERMA. Also, it is not visible to other users, only to the user 
who created it. To see how to make it permanent please see Step 11. 

 
 

Once you click OK the layer will be added to the ERMA Table of Contents at the bottom in a new 
folder called Temporary Layers. To delete the layer, click the trash can icon. 

 
 

Back at the Layer’s results tab, you can continue to create new temporary subquery layers, or to 
clear the filter delete the phrase from the search field and click Enter. 
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 When you are ready to export your data, return to the Results Summary tab. Decide whether you 
want to apply the filters to the exported data. 
• If you want to filter the data, select Apply filters to export. 
• If you want to export all of the data, select Export all data. 

 Clear the check box next to each layer that you do not want to include in the exported file.  

 Before exporting be sure to read the terms of agreement and check the box I agree to the terms 
for use outlined above. 

 Click the button for your desired data export format: Excel, KML, Shapefile, or Spatialite Database. 
When ERMA has finished creating the export file, a dialog box will ask you where you want to save 
the file.  

Adding Attribute Records to the Query by Polygon Tool 
You learned earlier that you can view the attribute data of any internally hosted data by right-clicking 
on its name in the Table of Contents to get the shortcut menu, then clicking View Data. 

 

If you manually select records, or create a filter to select records, of a polygon feature you can add 
these highlighted records to the Query by Polygon tool. 

To add polygon feature records to the Query Tab 
1. Once the View Internal Data window is open, click on the record(s) of interest to highlight it 

in green. 
2. At the bottom of the window click the Add Selected Features To Query Tab (Polygons Only) 

button. 



 

ERMA Basic User Guide: Query Tools Tab 

41 

 

3. Go to the Query Tools tab and your selected polygons will be outlined in blue and the polygon 
will be tinted gray. 

4. In the Table of Contents, select the other layer(s) that you would like to query with you selected 
polygon(s). When ready, click the Run ERMA Query by Shape button. 
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5. A new tab will appear with the results of your intersect query. The table will show you what 
data intersected within your selected polygon. 

 

6. You can now filter the results or export to one of the available formats. 

NOAA Environmental Sensitivity Index (ESI) Tool  
This tool allows you to create a NOAA Environmental Sensitivity Index (ESI) report that provides a 
summary of coastal resources that are at risk if an oil spill, or other hazardous incident, occurs. The 
summary includes biological resources, sensitive shorelines, and human-use resources.  

NOTE: You do not need to turn on any ESI layers before following the steps below, the tool pools from 
an internal ESI database. You will choose the layers you want to query during the procedure. 

To run an ESI query: 

 On the Query Tools tab, create one or more polygons using the procedure in Creating a Polygon.  
NOTE: Given the size of the ESI database and the time it takes to process large areas, it is a good 
idea to select a reasonably small area for your query (an island or section of shoreline, for example) 
rather than use a large region (such as an entire state). 

 Click on the polygon(s) that you want to use in your query. To select multiple polygons, press the 
SHIFT key and click on each polygon you want to include. 
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 Click the Run ESI Query button.  

  

 When the ESI Table Tool appears, select the data layers that you want included in the ESI report. 
All ESI Atlases that are available in your map view will appear so check any layers of interest from 
all available Atlases. 
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 Select the check box for each month that you want the ESI report’s data to cover. If you want data 
for a full year, click Check All. 

 
 If you want the report to include a section listing data that involves more than one of the 

information types that you have selected, select the Report Area Intersection Summary check 
box.  

 Click Run ESI Tool. A report is generated and then displayed in a new window similar to the one 
shown below.  
NOTE: If your ESI query does not produce results within a few minutes, you may need to quit the ESI 
tool and try again using a smaller polygon, fewer ESI layers, and/or fewer months. 
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U.S. Fish and Wildlife Service Information for Planning and 
Consultation (IPaC) Tool  
The Information for Planning and Consultation (IPaC) system provides information about U.S. Fish and 
Wildlife Service trust resources for your selected area, including threatened and endangered species. 
It also provides recommended conservation measures tailored to your project activities and trust 
resource species. 

To run an IPaC query: 

 Create one or more polygons using the procedure in Creating a Polygon.  

 Click on the polygon(s) that you want to use in your query. To select multiple polygons, press the 
SHIFT key and click on each polygon you want to include. 

NOTE: IPaC does not currently support points or line segments. If you need to define your project 
location as a point or line segment, draw a small polygon around the location.  

 Click the Run IPaC Query button.  
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 A new external USFWS webpage will open with the results of your query, including summary text, 
thumbnail photos, and links to more information.   

 

 

NOTE: For help using the IPaC tool, go to https://ecos.fws.gov/ipac/. 

https://ecos.fws.gov/ipac/


 

 

ZOOM TAB  
The Zoom tab allows you to zoom to a particular location in any of these ways: 

• By latitude and longitude 
• By the place name for a geographic location. 
• By NAIS ship location using a ship’s MMSI number or its name. 

Zooming By Latitude and Longitude (Lat/Lon) 

To zoom using latitude and longitude: 

 In the Zoom to Lat/Lon field, enter a known latitude and longitude in any of these formats:  
• Decimal degrees. For example: 

18.384, -65.655 
• Degrees decimal minutes. For example: 

66 45.8000W.) 
• Degrees minutes seconds. For example: 

-66 45 48 

 Select a zoom level from 1 (zoomed out to show the whole map) to 19 (zoomed in as close as 
possible). 

 Click Go. A place marker appears on the map at the exact location you selected. 
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Zooming By Place Name (Place) 

To zoom using a place name: 

 In the Zoom to Place field, enter the name of a geographic location or an address.  
Hint: Enter an address or geographic name in the same format that you would use with Google Maps 
or other popular online map application. For example: 

Chandeleur Sound, Louisiana. 

 A dropdown list of the exact or similar names will appear. Choose the one you would like to find. 

 Select a zoom level from 1 (zoomed out to show the whole map) to 19 (zoomed in as close as 
possible). 

 Click Find It! A place marker appears on the map at the location you selected. 
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Zooming By Ship Number (Ship MMSI) or Ship Name  
Users with the required privileges have access to the NAIS (Nationwide Automatic Information System) 
feed. This is a near real-time data feed that shows the name, location, status, and other details for most 
open-water vessels. If you know a particular ship’s Maritime Mobile Service Identity (MMSI) number 
or the ship's name—or at least part of the number or name—you can use this tool to find its last 
received location.  

To zoom by ship number:  

NOTE: It is helpful, although not necessary, to turn on the NAIS layer before or after zooming to a specific 
ship. It enables you to see the vessel locations and to use the Identify Tool to get additional information 
about the ship you’ve zoomed to. 

 Make sure you are logged in with the appropriate permissions to view the NAIS data (layer name 
NAIS - All Vessels (last 8 hours)). A new dialog box in the Zoom Tools panel will also appear. 

 In the Zoom to Ship MMSI field, enter at least four digits of the known ship’s 9-digit MMSI 
number. If more than one ship matches the number or digits that you entered, a drop-down list 
appears. Select the ship that you want from the list. 
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 Select a zoom level from 1 (zoomed out to show the whole map) to 19 (zoomed in as close as 
possible). 

 Click Find It! A place marker appears on the map showing the most recent received location of 
the ship.  

 

To zoom by ship name:  

 In the Zoom to Ship MMSI field, enter at least four characters of the known ship’s name.  
If more than one ship matches the name or characters that you entered, a drop-down list appears. 
Select the ship that you want from the list. 

 

 Select a zoom level from 1 (zoomed out to show the whole map) to 19 (zoomed in as close as 
possible). 
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 Click Find It! A place marker appears on the map showing the most recent received location of 
the ship.  

 

 

 

  



 

 

DOWNLOAD TAB 
ERMA users can download shapefile data to their computer for use in ArcMap or other GIS application. 

NOTE: Not all layers are available to download, some may be restricted. 

To download shapefile data: 

 On the Layers tab, turn on the layers that you want to download.  

 Select the Download tab. You’ll see a list of the layers that are available for downloading. You’ll 
also see the layers that cannot currently be downloaded, if there are any. 

 

 After reading the Terms of Use, check the box agreeing to these terms. 

 Click Download Source Data. Your browser will then prompt you to save a ZIP file that contains 
the full shapefile data.   
• No legend information is downloaded unless a LYR legend file was originally uploaded with the 

shapefile. In this case, the LYR file will be included.  
• Multiple shapefiles are saved into a single file called erma.zip rather than as separate ZIP files. 

Within that ZIP file are individual folders for each shapefile. 

Interoperability 
Sharing datasets among agency partners who use different systems is integral in the modern era of 
web mapping technology. One of ERMA’s strengths is its ability for “interoperability” between other 
web mapping and database systems. ERMA has been developed to easily ingest different types of data 
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from our partners, whether a WMS, ArcREST, or GeoRSS data feed from different server databases. For 
example, the field data collected by the EPA and managed in a database on their server can be quickly 
fed into ERMA. This allows the EPA to manage its own data, but for ERMA to display it to our specific 
audience. Our ERMA data managers work throughout the year with agency partners to ensure that 
ERMA can ingest their data seamlessly when an emergency situation may occur. 

Datasets that ERMA takes in and displays from other agencies will have an ERMA WMS Capabilities 
link in the layer’s metadata lite going to the host agency’s capabilities page. The user is able to use 
this information to bring the data into their own project. 

 

 
In addition to taking in external datasets, ERMA can provide WMS data feeds for all layers that it hosts 
as a shapefile and may not have a data feed from its originator. In a layer’s metadata lite window is an 
ERMA WMS Capabilities link that a user can use to bring the ERMA data into their own project.  
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ERMA can also provide WMS feeds to restricted datasets such as trajectories, field sampling, or SCAT 
data that may be created during an incident. The user will need to work with the ERMA data manager 
to obtain the token credentials for ingesting the protected ERMA WMS data. 
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PRINT TAB 
This tab allows you to print a PDF or PNG version of the map displayed in the ERMA window. The PDF 
is better for printing, and the PNG is better for using as an image in presentation software. 

To print a map displayed in the ERMA window: 

 On the ERMA window, select the Print tab. A thumbnail preview of your map and data are 
displayed in the right panel. This is a preview of what will appear on the printed map.  
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Under Paper Size, select the size of the paper you will print the map on, and the orientation of the 
map image on the paper.  

 
 Use the Map Tools on the left to adjust the zoom level of your map. You can also pan to the extent 

you want. The thumbnail preview will automatically update. 

 In your web browser, open the print settings and make sure that the paper size and orientation 
match what you have selected on ERMA’s Print tab. 

 Click Print to PDF or Print to PNG button. Depending on the number of layers that are turned on 
and the complexity of the map, it may take a minute for the map to generate. ERMA creates a 
printable PDF file that you can save to your desktop. When you open the PDF file, you'll see that 
the map includes: 

 An ERMA header with the region you are working in 

 A legend on the right 

 A footer at the bottom with the date the map was printed. If you are logged in, your name will 
also appear in the footer. 

  



 

 

ADVANCED TOOLS: DRAW TAB 
Certain users have access to ERMA Advanced Tools, including the Draw tool. If you have this 
permission then a new tab will appear on the right side of ERMA. The Draw tab allows you to draw 
points, lines, and polygons on the map, assign attributes, and share them with other ERMA users with 
the appropriate permissions. The drawings can also be made into ERMA layers in the Table of Contents 
and downloaded as GIS shapefiles depending on a user’s permissions. 

Draw Tab Overview 

View list of Drawings:  

Depending on your account permissions you will see up to four options to view different Drawings: 

1. Show All Drawings: By all users in all regions 
2. My Drawings: Only the Drawings you’ve created 
3. My Drawings + Shared Drawings: The default setting of your Drawings and any shared ones 
4. Shared Drawings: Only shared Drawings 
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The other default setting is for a checked box to Show Only Drawings in the [local] Region. If you 
have permission to see other regions then you will be able to see those drawings when this box is 
unchecked. 

 
To easily search the Drawings by Name or Region, type in the Search box and the Drawings table will 
be filtered by your search criteria. 

 
You can also sort the Drawings by Shared status, Name, or Region. Click on the field name and the 
column will automatically sort. A small black arrow will appear above the column that is being sorted. 
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Creating a New Drawing 

To create a new Drawing:  

Select the Draw tab and click New Drawing. The Create New Drawing panel will appear. 

 

NOTE: When users click the Draw tab, by default the user will see My Drawings + Shared Drawings only 
in their region.  

 

 
 Step 1: Name & Describe Your Drawing. In the Name field (required) type a descriptive name 

for your drawing. For example: 
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In the Description field (required), type of brief description of the drawing. This description will 
populate the metadata lite once the drawing is saved and the layer is created. 

 Step 2: Choose the type of drawing. In the drop-down menu you can pick points, lines, or 
polygons.  

NOTE: Until you have added a feature you can change the geometry type. Once a feature is added, 
you will need to either click cancel at the top right or delete all added features to change geometry 
type.  

 Step 3: Choose a Drawing Profile. By default, you will use the Drawing profile, but there are 
options to use other profiles to create commonly used features such as GRP Priority Sites or DARRP 
Cases. The profile option allows these common features to be standardized whenever they are 
made. The Draw tool will pre-populate some required fields (denoted by “auto”) and provide 
standard field names for you to fill out. Choose a profile then click the Show Field Names button 
to see what attributes have been standardized. 

 
 Step 4: Label, name attributes, and enter attributes. Click on the Show Fields Names button 

to expand the option of creating and naming fields for attributes. Add or remove field names as 
needed. The field names cannot contain spaces or special characters. You will be prompted if your 
field name does not meet the requirements. 

 
NOTE: By selecting Hide Field Names, these options will return to hidden.  
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Click on the Show Label Settings button to expand the option of customizing the labels size, color, 
and placement for your drawing. 

 
NOTE: By selecting Hide Label Settings these options will return to hidden. 

 Step 5: Create (or modify) a drawing feature. Select your Drawing Color, including an option 
to make the feature semi-Transparent to more easily see the map underneath. Click the 
appropriate drawing tool and add the features by clicking the map to or typing a lat/long.  
a. Polygon options – Choose a free-drawing polygon, a square, or a circle to create. When 

drawing the circle, click once to complete the drawing. Its Area, Diameter, and Radius will 
appear in a table at the bottom of the Draw panel. To draw the polygon, click the vertices on 
the map and double click to close the polygon when finished. The polygon’s Area will appear 
in a table at the bottom of the Draw panel. 

a. Line options – Click on the line icon then use your mouse to create the vertices on the map. 
Double click to complete the end of the line when finished. The line’s Length will appear in a 
table at the bottom of the Draw panel. 

b. Point options – Click on the point icon then click on the map to create a new feature.  The 
latitude/longitude fields will automatically be populated. Alternatively, you can enter a 
latitude/longitude in the fields then click the Add Point button to have it appear on the map. 
You can change the latitude/longitude and click the Update Point button as needed. 

Each feature you create will be listed in a table at the end of Step 5. You can edit a feature by 
clicking on it in the table and making changes to its size, color, etc. in the preceding steps. You can 
delete a feature by clicking on it then selecting the trash can symbol next to it. 
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 Step 6: Label and set attribute values. Once the shape has been created you have the option to 

create a Label and/or Set Attribute Values for each feature. If you have chosen to add attribute 
fields you can enter in values for the attributes in this section.  

NOTE: All shapes in each feature will share the same attributes. If you need different attribute values 
for other shapes then you will need to add another feature to enter those values. 
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NOTE: If you have multiple features you can choose to show all of them on the map as you work or 
you can show only the selected feature that you are working on. 

 Finally, click the Save Drawing button to add your Drawing to the table. ERMA stores the following 
metadata, which you see when clicking on your drawing in the table: 
• Name 
• Creator 
• Description 
• Profile Name 
• Create Date  
• Layer ID Number – each drawing is giving a unique ID number in the ERMA database 



 

ERMA Basic User Guide: Advanced tools: Draw Tab 

64 

  
 

 Once you click Save Drawing, your drawing will be listed in My Drawings under View Exisiting 
Drawings as well as in the table of contents. If you have the permissions to do so, here you can 
choose to Share your drawing with other users who have the permissions to see shared drawings. 
A green check box will appear next to the Drawing name indicating it has been shared. 

 

   
 
NOTE: To see drawings that other users have shared, select Shared Drawings from the drop down. 

NOTE: Drawings can only be deleted by their owner or by those with Admin permissions; a warning 
message will appear to ensure you want to delete your drawing. 
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Editing a Drawing 
ERMA allows you to modify Drawings that you created. Users with Admin permissions can edit 
Drawings created by others.  

To edit an existing Drawing:  

 Select the Draw tab, and open the drop-down bar to locate one of the options: 

• Show all Drawings – All drawings from across all ERMA regions will be displayed in a 
searchable table below.  

• My Drawings – Only drawings you have created will be displayed in a searchable table below. 

• My Drawings + Shared Drawings – Both drawings I have created and drawings that other 
users have shared with me will be displayed in a searchable table below. 

• Shared Drawings – Only drawings that other users have shared with me will be displayed in a 
searchable table below.  

 Once you have found the drawing you would like to edit, select the row. ERMA will automatically 
zoom to the extent of the drawing. 

 
 Directly below the table you will find the edit button (see above), click it.  

NOTE: You can only edit drawings that you own or if you have Admin permissions. 

 The Edit Drawing panel will appear. You will have the options to change, subtract, or add features 
to the drawing. 

 Based on your level of privileges, do any or all of the following: 
• Enter a new name or description, or use the Color drop-down list to change the color of the 

drawing’s figure. 
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• Change the figure's location by clicking anywhere on the figure and dragging it to the new 
location. 

• Change the figure's shape by clicking on any of the figure's vertexes (or on the grab point 
located in the middle of each side) and dragging.  

• Add additional points, lines, or polygons by selecting the appropriate tool and entering in 
coordinates or simply clicking on the map.  

NOTE: There is no “Undo” button so if at any time you would like to cancel the edits that have been 
made to the drawing, click Cancel at the top right-hand side of the panel.  

 

  
 If you would like to make edits to labels or set attribute values, do so in the last step, then click 

Save Drawing.  
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To Copy an Existing Drawing: 

You can copy one of your own drawings or another user’s drawing, rename it, and edit as needed. 

1. In the Drawings table highlight the drawing you would like to copy. 
2. Below the table click the Copy button. 
3. The Create New Drawing dialog panel will appear. Give a name to your copy, and edit the 

description, color, shape, or attributes. Click the Save button when finished. 
4. The copied Drawing appears in the table. By default, it is not shared. Click the Share button to 

share with other users. 

 

Adding a Drawing to the TOC 
There are two ways to add Drawings to the Layers tab, or ERMA Table of Contents: 

• Add a drawing to the My Drawings folder 
• Add a drawing to the Shared Drawings folder 

Each of these requires different account permissions. 

To add a Drawing to the My Drawings folder:  

Drawings that are not shared will appear in the My Drawings folder in the Draw tab and in the Layer 
tab’s Table of Contents. 

 If a drawing is removed from the Table of Contents by clicking on the trash can next to the layer, 
it can be added again by clicking the Add to Layers Tab button below the drawings table. This 
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will make the drawing appear in your My Drawings folder at the bottom of the Table of Contents. 
No other users will be able to see these drawings. 

 
 To remove this layer, click the garbage can icon next to the layer’s name.  

To add a Drawing to the Shared Drawings folder: 

 Drawings in the Shared Drawings folder must first be shared in the Draw tab. In the drawings 
table select the drawing you want to share and click the Share button. A green checkmark will 
appear next to the drawing’s name. 

 
Next, click the Add to Layers Tab button. ERMA will take you to the Layers tab. At the bottom of the 
TOC will be a folder called Shared Drawings with your new layer. Currently the layer is set to Public 
and anyone with access to ERMA can see the shared drawing.  

 
 

Download the Layer as a Shapefile 

Once your drawings have been added to the Layers tab, either as My Drawings, Shared Drawings, or 
in a TOC folder, you can download the layer as a GIS shapefile. 

 Click the checkbox next to the name of the layer or layers you want to download. 

 Go to the Download tab and click the Download Shape Files button. 
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 You will be prompted to save an ERMA.zip file to your desktop. Select the destination and click 

Save. 

 Unzip the file on your desktop. You will find a folder named with the LayerID number. Inside is 
another zip file with the shapefile named “drawing”. The attributes of your drawing will be in the 
shapefile DBF. 

 

 
 

 
 
  



 

 

APPENDIX 
This user guide was developed by NOAA’s Office of Response and Restoration Spatial Data Branch. 
For more information please contact orr.erma@noaa.gov and see the following resources. 

 

• Office of Response and Restoration ERMA webpage 
• Office of Response and Restoration Environmental Sensitivity Index webpage 
• Office of Response and Restoration DIVER webpage 
• ERMA Citation 

o ERMA. 2015. Web Application: [Regional ERMA Site] Environmental Response 
Management Application, National Oceanic and Atmospheric Administration. Retrieved: 
[Month, Day, Year], from http://erma.noaa.gov/[region] 

• ERMA Disclaimer 

o This Regional ERMA site was constructed for the purpose of presenting data to assist in 
response planning, site assessment and restoration activities and decision making in the 
region. Unless otherwise noted, the data contained within this site have undergone only 
limited NOS quality assurance review; however, the data may have not yet undergone 
final verification by the data producer. Users of these data should refer to the original, 
authoritative sources and review the provided metadata to understand the currency and 
limitations of the data from these data providers. NOAA cannot guarantee the accuracy 
or completeness of data provided by other agencies or partners. 

• NOAA National Ocean Service Privacy Policy 

mailto:orr.erma@noaa.gov
https://response.restoration.noaa.gov/maps-and-spatial-data/environmental-response-management-application-erma
https://response.restoration.noaa.gov/maps-and-spatial-data/environmental-sensitivity-index-esi-maps.html
https://response.restoration.noaa.gov/environmental-restoration/environmental-assessment-tools/diver.html
https://erma.noaa.gov/local/citation.html
https://erma.noaa.gov/disclaimer.html
https://oceanservice.noaa.gov/privacy.html
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